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Large Format Graphics 
Information Bulletin 
Number: 1006  •  Issued by CPP LFG Customer Support, Venlo  •  25 April 2022 
 
 
 
 

Colorado 1630 & C1650 FLXfinish+ How-to guide 
 
 
 
Introduction 
This document describes how to create files FLXfinish+, how to set up the RIP, Fixes & work-arounds 
and tips & tricks for the Colorado 1630 printer & Colorado 1650 printer. For FLXfinish+, the Colorado 
1630 needs to be running on system software version V3.1 or higher and Colorado 1650 running on 
system software version V2.5 or higher. Onyx version 21.1 or higher and Caldera V15 or higher is 
needed. 
 
The Colorado has two types of print modes; Gloss and Matte which require different curing strategies 
and therefore different print modes, The Gloss and Matte print modes combined creates the 
FLXfinish+ print mode. In order to print with FLXfinish+ a print file needs to be prepared in a software 
that supports a spot layer or channel and the RIP needs to be configured properly in order to get the 
correct outcome. 
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1. RIP Setup 

 
In order to use FLXfinish+ applications, a CMYKSS profile with a FLXfinish+ print mode is needed. These 
media profiles can be downloaded from GraphiPLAZA and or Mediaguide.cpp.canon. A media profile 
with FLXfinish+ print mode can also be created from scratch, using the profiling documentation from 
C1650/C1630. These documentations can also be found on GraphiPLAZA or at downloads.cpp.canon. 
 
Next to that certain media profile settings and PDF file settings can be checked to verify whether the 
PDF file will be printed properly. 

1. Media Profile settings 

• For Onyx: 

In order to print both matte and gloss, the media profile needs to be a CMYKSS profile. This can 
be checked at the following location: 
In media manager, select the media profile and the information regarding spot colors will be 
provided on the right. If the media is set up correctly, it will show CMYKSS at ink configuration and 
2 defined spots. 

 
Note: It is possible that different colors for Spot2/Gloss are used per media profile. The media 
profile is set properly as long as there are two spots defined. The colors used for Spot2/Gloss is a 
matter of preference. 

 
• For Caldera: 

Caldera does not need to use a CMYKSS profile. The current CMYK profiles can have FLXfinish+ added 
to it. The only thing that needs to be done is that either the Gloss High Quality print mode is copied 
to FLXfinish+ or that a FLXfinish+ print mode is made from scratch. 

 

2. PDF file settings 

 
In order to verify if the PDF file is prepared correctly, two things will need to be checked. 
 

https://graphiplaza.cpp.canon/media/
https://mediaguide.cpp.canon/
https://graphiplaza.cpp.canon/support/product/colorado-colour-management-resources/
https://downloads.cpp.canon/
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• For Onyx: Open the PDF file in Job Editor and select the correct media profile and print mode. 
Under Output it should show that CMYK + 2 spots is available and at Source Image under 
Format: CMYK, + 2 spots. This will indicate that this file has been made up for FLXfinish+. 

 
However, to check that the gloss part will be printed: hover the mouse over an area in the 
image that should be printed in gloss. Check at the bottom of the Job Editor whether there is 
a CMYK value and Spot2 value. If that is the case, the PDF file is made up correctly and will be 
printed in matte and gloss when using the FLXfinish+ print mode. 
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• For Caldera: Open the correct printer version and in this case it’s Colorado-1650-R2.5. Set the 
correct media profile and print mode and drag the desired FLXfinish+ PDF file to the image 
selection area. Go to the Spot button. 

 
 
Check if Spot Color Gloss is present under Spot Colors 

 
 
Next double click on the file itself in the files window, this will allow the file to be opened and 
checked on the CMYK and Spot color percentages. Hovering the mouse of the Spot Color area 
should give a CMYK value and Spot Color value named S. 
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Note: If either the CMYK value or Spot 2 value is not present: Go to $2.1 if Spot2/Gloss value is not 
present or go to $2.2 if CMYK  value is not present. 
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2. Fixes and work arounds 

 
There are several mistakes that can be made during PDF file preparation. In this chapter the common 
issues/mistakes will be described. 

2.1 The Spot2/Gloss is not recognized by the RIP 

There are two reasons as to why Spot2/Gloss is not recognized by the RIP 
 

  
 
Reason 1: Spot color is named wrong in the PDF file.  
Therefore, the RIP does not recognize it as Spot2 (Onyx)/Gloss(Caldera) and treats it as a regular spot 
color. When printed, the PDF file will be printed completely matt and the spot area’s will use the spot 
color. 
Check: 

• Onyx: It can be checked whether the Spot2/Gloss name is recognized by going to job editor. 
Spot2 should appear under Named Colors. If it doesn’t show there but a different similar 
name, then the name for the spot color is wrong. 

 
• Caldera: For Caldera this can be checked when preparing the file for printing, by going to the 

Spot settings and check if a Spot color is visible and what they name is 
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Solution 1: Open the PDF file in Photoshop / Illustrator or another program and fix the spot color name 
to: 

• Onyx: Spot2 
• Caldera: Gloss 

Solution 2: The Spot color name can also be fixed in the RIP 
• Onyx: Job Editor: Go to ‘Change Profiles’ under Color management and go the Output tab. 

Click on ‘Spot Channel Replacement’ and type name which has been used in the PDF file 
(instead of Spot2). In the example below VERNIS needs to be changed to Spot2 

 
 

• Caldera: Go to the server admin window, select the correct printer and click configure. Edit 
the list of color names that should be automatically associated to "Gloss", for example add 
the rule "Spot2 -> Gloss" 
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Reason 2: The Spot color is named correct but isn’t a spot color but process color 
 
Check: 

• Onyx: Check if Spot2 is visible under Named Colors at Job Properties. If there is no name, then 
Spot2 isn’t a spot color but process color. 

 
 

Solution: Open the PDF file in Photoshop / Illustrator or another program and change Spot2/Gloss 
from process color to Spot color. 
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2.2 No CMYK values visible 

 
It is possible that spot color is set correctly and that it’s visible in the RIP, but no CMYK values are 
visible. The print output will instead show no color at all. 
 

  
 
Reason: over print fill and/or stroke in the PDF is not checked. 
 
Solution: Open the PDF file in Illustrator or another program and check the overprint boxes in the 
attributes. More information can be found in Chapter 2 How to create FLXfinish+ file. 
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2.3 Strange colors/artefacts appear in the PDF file viewer (Onyx/Caldera) 

It is possible that weird shapes and colors are visible in the PDF file which are seen in the PDF file 
viewer and also in the output. 

 
 
Reason: Spot color objects with transparent objects or shadowing effects etc. on top can cause color 
management issues in the RIPs 
 
Solution: There are a few steps to take to solve this issue 

► Save the file with Illustrator as PDF 1.3 
► Rasterize content 
► Flattening gets rid of the transparency, thus some of these color management issues 

could be fixed with Acrobat Pro use “Flatten transparency” or similar fixups 
 
For example: 

     
Saved as PDF 1.5  Saved as PDF 1.3 
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2.4 A part that is supposed to be Matt also became glossy 

It is possible that a part of the file which should be printed Matte, comes out glossy because it’s 
underneath the Spot2 layer. See the image below; the Gold circles and text should be matte. But will 
be printed in gloss if left like this. 

 
 
Solution: Add another layer above the Spot2 layer and copy and paste the parts that need to be matte 
into that layer. It will now be printed matte. 

  

2.5 Caldera/Onyx does not recognize the Spot color in a TIFF file 

It is possible that when saving the FLXfinish+ file as a TIFF with RGB channels that Caldera/Onyx won’t 
recognize the Spot2 channel. 
 
Reason: 
If the file is saved as a TIFF, then it doesn’t matter what each channel is named, but instead it searches 
for the information in the 5th layer: 

• In case of a CMYK image, the Spot2 Channel is automatically the 5th Channel. This means that 
no extra steps need to be taken. 

• In case of an RGB file, there are only three channels (R-G-B), which means that when adding 
the Spot2/Gloss channel it will be the 4th channel instead of the 5th and therefore won’t be 
recognized. In order to make a RGB TIFF file work, make sure to add a filler channel (4th 
channel) and then create a 5th channel with the Spot2/Gloss information. 
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3 Tips & Tricks 

As FLXfinish+ is not the same as Varnish/Spot Gloss, the way of thinking is also slightly different. For 
example the type of media has more influence on the outcome especially when it comes to low density 
colors. However, the registration is near perfect because it is printed in line and no extra ink/clear 
liquid or waiting time is needed to print. 
With that in mind we’ve gathered some do’s and don’ts. 

3.1 Media 

• As UVGel ink sits on top the media when cured, the type of media structure will have an 
influence on the outcome of the print: 

• Very structured media will make gloss areas become more matt looking, which will 
result in small differences between the gloss and matt area.  

• However, a slightly structured media can result in a more satin effect, giving some 
difference between gloss and matt.   

• With smooth media, it will result in the largest effect between Gloss and Matte. 

                  
          Slight structure (IJM703)  vs Smooth(IJM707)  Structured (IJM417)    vs Smooth (IJM707) 

 
• Printing FLXfinish+ can only be done with media that is suitable for gloss print modes. Certain 

media cannot be printed in gloss due to porosity of the media, which will absorb the ink and 
may lead to uncured ink and a matte outcome. 

• Therefore any media that is not suitable for gloss print modes is also not suitable for 
FLXfinish+ 

• The profiles with FLXfinish+ that will be available on mediaguide or graphiPLAZA are 
suitable. 
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3.2 Files 

• Using Color on Color can give some really nice effects: 

  
 
 
 
• High accuracy with fine lines: 
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• Low density areas or white areas in a file will result in the media showing, which means that 

the media will also play a role in the gloss/matt effect: 
o The gloss level of the gloss part depends on the coverage of the gloss part and the 

gloss level of the medium. 
o Similarly, the matt level also depends on the coverage of the matt part and of the 

gloss level of the medium. 
o The effect of the media is most visible in coverages between 0-30% and has barely 

any effect at coverages of 60% and above. You can however still observe differences 
between gloss and matt at 10% coverage. 

  
Minimal gloss effect with low coverage area’s              The white and gloss level of the media have an effect 
 

 
 

• For the ratio between Gloss and Matte; It works best to use Matte as base and use Gloss as 
accents. The eye catches the effect more when the Gloss parts are the accents. 

 
Background: Gloss  vs     Matt (Do note that different colors were used in these files) 
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4. How to create a FLXfinish+ file 

Use a program that allows to use layers, channels and spot colors like Adobe Illustrator and photoshop. 
Select a base file, this can be any type of file such as a photo or vector.  
 

4.1 Illustrator 

This section explains how to prepare images for FLXfinish+ with a vector-based image with Adobe 
Illustrator. In order to set up a file for FLXfinish+, spot color data needs to be added in a new separate 
layer (Spot2 for Onyx or Gloss for Caldera).  It is possible to have more than one spot element in an 
image/vector, but each element must be on the same spot layer and have the same spot color 

4.1.1 Setup the Spot color: 

1. Ensure that the Swatches tab is visible (under the window menu click swatches to view). 
2. Click the arrow on the Swatches tab to display the Swatches menu. 
3. Select New Swatch from the Swatches menu to open the Add Swatch Dialogue. 
4. Within the Add Swatch dialogue, enter the following information: 

• Swatch name: Spot2 (Onyx) or Gloss (Caldera) 
• Color type: Spot Color 
• Color mode : CMYK 
• CMYK value: your preference (in this case 50% M is used) 

 
5. Click OK to save your changes and close the Add Swatch Dialogue. You should now have a new 

Spot Color in your swatch pallet, which is indicated with a small dot on the bottom right side 
of swatch. 
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4.1.2 Set up the Spot layer: 

1. Ensure that the Layers tab is visible (under the window menu click Layers to view). 
2. Click the arrow on the Layers tab to display the Layers menu. 
3. Make sure you have the base file information in one (or more) layer(s) (for example named 

‘Base’).  
4. Select New Layer from the Layer menu to create a second layer and make sure that the layer 

is above the base layer (for example named ‘Spot2’). 

   
5. Select the parts of the image that needs to be printed glossy and copy it and paste it into the 

Spot2 layer. Tip: paste it with ctrl+v+shift to place it on the exact same spot as the base layer. 

  
6. Select the Spot2 layer (press the cirkle behind the ‘Spot2’ and apply the Spot2 swatch created 

in the Spot Color setup. 
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4.1.3 Overprint fill & Stroke  

By default, when you print opaque, overlapping colors, the top color knocks out (cuts a hole) in the 
area of the colored image underneath(base layer). Overprinting prevents knockout and allows the 
colored image from the base layer to be printed.  

1. Ensure that the Attributes tab is visible (under the window menu click Attributes to view). 
2. Select the Spot 2 layer in the Layer menu and click the arrow on the Attributes tab to display 

the Attributes menu. 
3. Depending on the image both over print fill and overprint stroke are available and in some 

cases only one of the two is available. 
4. If both boxes are visible then check both boxes, if only one box is visible then check that one 

box. 

  
  

4.1.4 Save PDF File 

Save the file as a pdf and make sure to select PDF 1.3. This has to do with the fact that certain files 
are made up with shadow effects and so forth that may be used in the vector that could cause 
issues with the print outcome. 
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4.2 Photoshop 

This section explains how to prepare images for FLXfinish+ with an image with Adobe Photoshop. In 
order to set up a file for FLXfinish+, spot color data needs to be added in a new separate Spot Channel 
(Spot2 for Onyx or Gloss for Caldera).  It is possible to have more than one spot element in an image, 
but each element must be on the same spot channel, and therefore have the same opacity level. 

4.2.1 Select desired gloss part of image 

1. Open the PDF file in Photoshop (If the file is in RGB mode, then it can convert it to CMYK) 
2. Use the desired selection tool (e.g. the Magic Wand) to select the area of the image you wish 

to print in gloss. 
3. In some cases, it may be easier to select the area in which you don't want any gloss data and 

then select the inverse. 

4.2.2 Create Spot Channel 

1. Ensure that the Channels tab is visible (under the Window menu click Channels to view the 
panel) 

2. Click on the arrow on the Channels tab to display the Channels menu. 
3. Select New Spot Channel from the Channels menu to open the Add Spot Channel Dialogue. 
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4. Within the Add Spot Channel Dialogue, enter the following information: 

1. Name: Spot2 (Onyx) or Gloss (Caldera) 
2. Opacity: 100% 
3. Edit the channel COLOR by double-clicking on the swatch. Set the spot color to your 

liking. 
5. Click ok to save your changes and close the Add Spot Channel dialogue. 

 
6. The Gloss part should now be visible in the Spot2 Channel and have the color of the Spot2 

Channel (if the Gloss part was selected). 

 

4.2.3 Save the file 

Save the file as a PDF and make sure that ‘Spot Colors’ and ‘layers’ is checked. 
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